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Abstract 

Seven Hills Neighborhood Houses would like to facilitate the networking of 

computers at each of the four branches. They believe a computer networking system will 

enhance their communications and enable them to share pertinent information common to 

all branches. It will also help to share ideas around service improvements and/or service 

innovations. 

The Seven Hills Neighborhood Houses would also like to establish a 

comprehensive database to store and access client information. The database will hold the 

clients' personal information and the services they have received. This will enable the 

staff to use information technology to improve the efficiency, accuracy, and timelessness 

of the various reports and documents they are required to keep. 
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Development of a Database Program and Networking System 
For Seven Hills Neighborhood Houses 

1 Statement of the Problem 

1.1 Definition of the Need 

Seven Hills Neighborhood Houses is a non-profit United Way Funded-Agency. 

Their purpose is to increase the resources available to their constituents, who have 

historically had few alternatives. Their goal is to provide those services that are most 

needed and best delivered from a community-based agency. The rational is to build 

partnerships with residents, private(public organizations and businesses to enhance 

resources to ensure maximum opportunities for individuals, families and community 

growth. The organization consists of an Administrative Office and three satellite branches 

located within Greater Cincinnati. The Administration Office located on 1809 Freeman 

A venue delegates the business and financial side of the organization. The Findlay Street 

Neighborhood House is located on 901 Findlay Street. The West End Branch offers a 

variety of programs including: Emergency Assistance, Computer Training, Parenting 

Classes and Victims of Crime Counseling. The East End Branch residing on 3806 Eastern 

A venue in the East End offers assistance and counseling services. The Valley Branch on 

1100 Lindy Street in Lincoln Heights offers activities such as: Computer Training, 

Building Blocks After School Program, Neighborhood Planning and Counseling. Simply 

put by their mission statement "Building Communities One Family At A Time". 

Currently they do not have the capability to correspond and share information 

other than primitive means such as phone, fax or mail. The sharing of information occurs 

at a monthly managers' meeting and/or through the agency's informal network. A 
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majority of their 25 computers are inefficient and require hardware and software 

upgrades. Reports and client tracking are manual and prone to human error. The process 

is tedious and time consuming. 

2 Description of the Solution 

A wide area network will connect the branches and allow instant access to client 

information stored in a central database. A user-friendly application will provide a 

computer-based means of updating and requesting data from the database. The front end 

will generate instant reports pulling data directly from the database. The network and 

database will increase communication and improve efficiency. 

2.1 Project Design 

I plan to use three areas within the Information Engineering Technology program 

to complete the project. The front end is a Visual Basic application compiled in the form 

of an executable program located on client computers. The application will access the 

data stored in the Microsoft SQL database through an open database connection. The 

branch offices are networked together creating four distinct local area networks. 

Workgroups were created at each location to help users find objects such as printers and 

shared folders within that group. Once Seven Hills contacts the Internet Service provider 

the routers will then allow the user immediate access to the database from any location 

using the server' s static IP address. Below I have listed in detail the specific areas and 

how they are used in my project. 

2.1.1 Microsoft SQL 2000 Enterprise Edition 

Microsoft SQL Server 2000 is the market leader and database of choice for this 

project. SQL Server is the fastest growing relational database with 45 percent revenue 



growth--over three times faster than the overall relational database market. SQL Server 

is the most popular relational database on Microsoft Windows, with 38 percent market 

share (Gartner, June 2001). Figure I provides a breakdown of the relational database 

market share. 
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Figure 1. Database Market Composition 

SQL Server 2000 on Windows 2000 provides the best performance on the SAP 

R/3 Sales and Distribution Standard Benchmark on any platform, supporting 26,000 

concurrent sales and distribution users- 34 percent more than Sun/Oracle. Performance, 

scalability, and reliability are essential to the organization. Microsoft SQL Server 2000 

will provide a reliable and highly scalable database for Seven Hills. SQL Server 2000 

takes advantage of symmetrical multiprocessor (SMP) systems. SQL Server Enterprise 

Edition can use up to 32 processors and 64 GB of RAM. Effective table structures, 

relationships, and database normalization will optimize database performance. The 

database is created so that it shows a many to many relationship to efficiently hold and 

retrieve client information (refer to Appendix A). The database will consist of the 

following tables: Client Table, Emergency Contact, Client Details and nine Activity 

Tables. The client's social security number is a unique value therefore will be the primary 

key. The executable application provides an open database connection to the server. The 



server is set up with a static IP address allowing access from the various branches via the 

Internet and the open database connection. Security for the server will rely on router level 

security to prevent hackers from gaining access to the data. The server is located on the 

first floor at the Administrative Office. A disaster plan was created to document backing 

up the database and restoring the data. A digital copy of the disaster plan resides on the 

server and a paper copy is stored at the Administrative Office. 

2.1.2 Networking 

Networking will play a vital role in the project. The four branches collectively 

will create a wide area network allowing instant access to the server from any location. 

The computers are set up in distinguishing workgroups. Some of the workstations are 

inefficient requiring hardware and software upgrades. A majority of the workstations will 

receive a new Network Interface Card replacing 1OMB cards with NETGEAR 10/100 

PCI Adapters, allowing faster data exchange rates. The East End, Findlay Street, and 

Valley Branch will require installing a GIGAFAST 4-Port Router at each location to 

access the Internet. The Findlay Street Branch requires a NETGEAR 8 Port Hub to 

accommodate the number of computers. The East End, Findlay Street, and Valley Branch 

will receive CAT -5e cable drops connecting each computer to the Hub/Router. 

2.1.3 Programming 

Microsoft Visual Basic 6.0 development system is the most productive tool for 

creating fast business solutions for the Microsoft Windows operating system and the 

Web. With its rapid application development (RAD) environment, developers can 

quickly create and deploy super-fast client/server applications using familiar Visual Basic 



programming techniques. A Visual Basic 6.0 application will serve as the front end of the 

database. Users will have a series of forms: View/Modify Client Information, Add New 

Client, Client Activities and Metrics. There are validations on several fields within the 

forms to protect the integrity of the data. During run time the sub routines are coded to 

identify and report any errors. An open database connection will connect the Visual Basic 

6.0 front end to the Microsoft SQL 2000 database. The ADO Data Control will allow the 

user to move through the records in the recordset. The Metric menu retrieves data from 

the database and displays the data in Microsoft Excel using a pivot table. 

2.2 User Profile 

The intended users for the database and application will be at two levels of IT 

literacy. The distinct levels are Data Entr and Management. Proper documentation and 

training is key in the success of the deployment of the executable application and 

maintenance of the database. 

2.2.1 Data Entry 

Data entry employees are responsible for entering new client information, 

modifying client information and selecting client activities. Several of the data fields are 

dropdowns eliminating user error. Within the code, key fields are validated and a 

message box will warn the user if he/she has violated the parameters. The dropdowns and 

validation sequence are established to maintain the highest level of data integrity. Basic 

understanding of Microsoft Word and Microsoft Excel are the highest level of IT 

knowledge. 



2.2.2 Management 

One key role of management is to analyze client statistics. The Metric menu 

retrieves data from the database and displays the data in Microsoft Excel by means of a 

pivot table. After the user enters specific criteria the front end will then execute the SQL 

statement behind the scenes retrieving the necessary data. The View/Modify Client 

Information page will allow management to scroll the recordset of existing clients using 

an ADO Control. The management team is responsible for backing up the Microsoft SQL 

database. The management team also has the authority to delete records on the database. 

2.3 Design Protocols 

The primary means of sharing information prior to the local area network and 

database consisted of a fax machine and telephone. Communication and data sharing 

between the satellite offices and the Administrative Office were limited and slow. The 

design protocols detail the individual branches. 

2.3.1 East End Branch Protocol 

My analysis led to a full computer upgrade and a local area network combined to 

enhance communication and enable them to share pertinent information. Figure 2 lists the 

expenses. 

Product Quantity Price Sub Total 

CAT-5e 10/ 100 Base-T Patch Cable - I 00 Feet 4 $18.00 $72.00 

GIGAFAST 4-Port Router $69.99 $69.99 

64MB EDO DIMM 6 $12.00 $72.00 

Seagate 4.3 GB Hard Drive 2 $39.00 $78.00 

Seagate 4.3 GB Hard Drive $19.99 $19.99 

NETGEAR 101100 PCI Adapter 
,.., 

$11.00 $33 .00 .) 

Microsoft Windows 2000 Professional Upgrade 4 $219.00 $876.00 
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I Microsoft0ffice2000 Professional I 4 1$399.99 1$1 ,599.96 

I The Complete Reference Word 2000 .-1 ---~ $4.99 I $4.99 

I I l ~~-
1 Note: $ 19.99 Seagate 4.3 GB Hard Drive purchased from eBay I I I 

1 

l I I Total .-l$2- ,-82-5-.93-

Figure 2. East End Branch Budget 

Windows 2000 Professional is the Windows operating system of choice for 

business desktop and laptop systems. It is used to run software applications, connect to 

Internet, access files , printers, and network resources. A workgroup was created to help 

users find objects such as printers and shared folders within that group. By sharing 

folders and printers the East End branch will increase communication and in tum 

streamline processes and become more efficient. 

The East End branch received a Microsoft Windows upgrade. The operating 

system went from Microsoft Windows 95 to Microsoft Windows 2000 Professional with 

Service Pack 2. Windows 2000 will provide a secure operating system and allow the 

computers in the branch to share folders and files. The Hard Drives and RAM needed an 

upgrade to meet the minimum requirements for Windows 2000. New Hard Drives and 

RAM were installed in 3 of the 4 computers. The network cards were also upgraded in 3 

of the 4 computers to speed up data communication. The East End branch also received a 

Microsoft Office upgrade. The office package went from Microsoft Office 97 to 

Microsoft Office 2000 Premium. Figure 3 lists the East End software/hardware upgrades. 



Computer 1 Computer 1 After Upgrade 
G t PS 100 a eway -

Microsoft Windows 
Microsoft Windows 2000 

Operating System 
95 

Operating System Professional with Service 
Pack 2 

Office Package Microsoft Office 97 Office Package 
Microsoft Office 2000 

Premium 

Hard Drive I GB Hard Drive Seagate 4.3 GB Hard Drive 

Random Access Memory 16MB Random Access Memory 128MB 

Allied Telesyn AT-15 10 
NETGEAR 10/100 PC! 

Network Interface Card Plug & Play Ethernet Network Interface Card 
Adapter 

Adapter 

Computer2 Computer 2 After Upgrade 
G t E 1400 a eway -

Microsoft Windows 98 
Microsoft Windows 2000 

Operating System 
Second Edition 

Operating System Professional with Service 
Pack 2 

Office Package Microsoft Office 2000 Office Package 
Microsoft Office 2000 

Premium 

Computer 3 Computer 3 After Upgrade 
G t PS 100 a eway -

Microsoft Windows 2000 
Operating System Microsoft Windows 95 Operating System Professional with Service 

Pack 2 

Office Package Microsoft Office 97 Office Package 
Microsoft Office 2000 

Premium 

Hard Drive I GB Hard Drive Seagate 4.3 GB Hard Drive 

Random Access Memory 16MB Random Access Memory 128MB 

Allied Telesyn AT- 1510 
NETGEAR 10/100 PC! 

Network Interface Card Plug & Play Ethernet Network Interface Card 
Adapter 

Adapter 

Computer 4 Computer 4 After Upgrade 
G t PS 100 a eway -

Microso ft Windows 2000 
Operating System Microsoft Windows 95 Operating System Professional with Service 

Pack 2 

Office Package Microsoft Office 97 Office Package 
Microsoft Office 2000 

Premium 

Hard Drive I GB Hard Drive Seagate 4.3 GB Hard Drive 

Random Access Memory 16MB Random Access Memory 128MB 

Allied Telesyn AT-15 10 
ETGEAR 10/100 PC! 

etwork Interface Card Plug & Play Ethernet Network Interface Card 
Adapter 

Adapter 

Figure 3. East End Computer Specs 
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The computers are networked using a star topology. A GIGAF AST 4-Port Router 

was installed and each of the four computers were then connected to the router. Not only 

can the GIGAFAST 4-Port Router serve as a 4-port switch for creating the 10/ lOOMbps 

network, it also has IP Sharing and network security features, making it the most 

complete router solution available. Serving as an advanced firewall , the GIGAF AST 4-

Port Router prevents hackers from entering the private network. The WAN port may be 

connected to the incoming Cable/DSL!Ethernet signal with up to 253 client computers 

connected directly or through other hubs and switches to the 4 1011 OOMbps ports on the 

GIGAF AST 4-Port Router. The GIGAF AST 4-Port Router will then assign IP addresses 

using its built-in DHCP server, allowing client computers to receive TCP/IP settings 

directly from the router. Then through one of the client computers, the GIGAF AST 4-

Port Router is configured so that all the client computers will be able to share the Internet 

connection. The front-end application is coded with an open database connection to allow 

users to gain access to the server via the Internet. Figure 4 illustrates the network 

topology for the East End Branch. 

~ 

I g. 

• Computer4 

Figure 4. East End Branch Network Topology 



2.3.2 Findlay Street Branch Protocol 

My investigation led to a partial computer upgrade and a local area network. The 

local area network will develop communication and enable them to share related 

information. Figure 5 lists the expenses. 

Product Quantity Price Sub Total 

CAT -Se I 0/100 Base-T Patch Cable - I 00 Feet 5 $18.00 $90.00 

CAT -Se I 0/ I 00 Base-T Patch Cable - 50 Feet 3 $15.00 $45 .00 

CAT -Se I 0/ I 00 Base-T Patch Cable - 25 Feet 1 $9.00 $9.00 

CAT-Se 10/100 Base-T Patch Cable - 7 Feet I $3 .00 $3.00 

GIGAF AST 4-Port Router I $69.99 $69.99 

NETGEAR 8 Port Hub I $33 .00 $33 .00 

NETGEAR I 0/ 100 PCI Adapter 8 $11.00 $88.00 

Microsoft Windows 2000 Professional Upgrade 3 $219.00 $657.00 

I Microsoft Office 2000 Premium 
,., 

$399.99 $1 , 199.97 .) 

I Microsoft Windows 98 Second Edition I $84.99 $84.99 

I Microsoft Office 97 Professional Edition 3 $259.00 $777.00 

1 64MBPCIOO 4 $10.00 $40.00 

I I I I 
I I I Total 1 $3,096.95 

Figure 5. Findlay Street Branch Budget 

A workgroup was created to help users locate objects such as printers and shared 

folders inside that group. By sharing folders and printers the Findlay Street branch will 

boost communication and in turn modernize processes and become more efficient. 

The network cards were upgraded in all nine computers to speed up data 

communication. NET GEAR F A31 0 TX network cards were installed in all nine 

computers. The NETGEAR F A31 OTX is an auto-sensing, 1 OOBASE-TX Fast Ethernet 



~--~---------------------------------------------------------

PCI adapter. It will operate with either 1 0 Mbps 1 OBASE-T or 1 00 Mbps 1 OOBASE-TX 

hubs or switches. Figure 6 lists the Findlay software/hardware upgrades. 

Computer 1 
ACER 

Operating System 

Office Package 

Network Interface Card 

Computer 2 
G PS 100 ateway -

Office Package 

Network Interface Card 

Computer3 
G t 400 a eway 

Operating System 

Office Package 

Random Access Memory 

Network Interface Card 

Computer 4 
G t PS 100 a eway -

Office Package 

Network Interface Card 

Computer 6 
G t PS 100 a eway -

Operating System 

Office Package 

etwork Interface Card 

Microsoft Windows 98 

Microsoft Office 97 

Motorola Modem SURFR 
Internal 28.8 Plug & Play 

Microsoft Office 5.0 

Intel 82559 Plug & Play 
Ethernet Adapter 

Microsoft Windows 98 

Microsoft Office 2000 

64MB 

US Robotics 56K Voice Win 

Microsoft Office 5.0 

Allied Telesyn AT- 151 0 Plug& 
Play Ethernet Adapter 

Allied Telesyn AT - 15 10 Plug & 
Play Ethernet Adapter 

Microsoft Windows 95 

Microsoft Office 6.0 

Allied Telesyn AT- 15 1 0 Plug & 
Play Ethernet Adapter 

Computer 1 After Upgrade 

Operating System Windows 98 Second Edition 

Office Package Microsoft Office 2000 Premium 

Network Interface Card 
NETGEAR 101100 PCI 

Adapter 

Computer 2 After Upgrade 

Office Package Microsoft Office 97 Professional 

Network Interface Card NETGEAR 10/100 PC! Adapter 

Computer 3 After Upgrade 

Operating System 
Microsoft Windows 2000 

Professional with Service Pack 2 

Office Package Microsoft Office 2000 Premium 

Random Access Memory 128MB 

Network Interface Card NETGEAR I 01100 PCI Adapter 

Computer 4 After Upgrade 

Office Package Microsoft Office 97 Professional 

etwork Interface Card NETGEAR 101100 PCI Adapter 

Computer 5 After Upgrade 

Network Interface Card NETGEAR 101100 PCI Adapter 

Computer 6 After Upgrade 

Operating System Windows 98 Second Edition 

Office Package Microsoft Office 97 Professional 

Network Interface Card NETGEAR 101100 PC! Adapter 
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Computer 7 
c ompaq 

Operating System 

Office Package 

Random Access Memory 

Computer 8 
IBM A tiva 

Operating System 

Office Package 

Random Access Memory 

Network Interface Card 

Microsoft Windows 95 

Microsoft Office 97 

32MB 

Microsoft Windows 98 

Microsoft Office 97 

96MB 

LTWin Modem 

Computer 7 After Upgrade 

Operating System 
Microsoft Windows 2000 

Professional with Service Pack 2 

Office Package Microsoft Office 2000 Premium 

Random Access Memory 128MB 

Computer 8 After Upgrade 

Operating System 

Office Package 

Random Access Memory 

Network Interface Card 

Microsoft Windows 2000 
Professional with Service Pack 2 

Microsoft Office 2000 Premium 

160MB 

NETGEAR I 0/100 PC! Adapter 

Computer 9 After Upgrade 

Standard 1200 Bps Modem Network Interface Card NETGEAR 10/100 PCI Adapter 

Figure 6. Findlay Street Computer Specs 

The computers are networked using a star topology. A NETGEAR FE1 08 8-Port 

Hub was installed and seven of the nine computers were then connected. The NET GEAR 

FE108 8-Port Hub provides fast information exchange, resource sharing, and client or 

peer-to-peer communication using simple Category 5 unshielded twisted pair (UTP) 

wiring. The hub was then wired to the GIGAF AST 4-Port Router and the remaining two 

computers were then connected to the router. Not only can the GIGAF AST 4-Port Router 

serve as a 4-port switch for creating the 10/1 OOMbps network, it also has IP Sharing and 

network security features, making it the most complete router solution available. Serving 

as an advanced firewall , the GIGAF AST 4-Port Router prevents hackers from entering 

the private network. The WAN port may be connected to the incoming 

Cable/DSL/Ethernet signal with up to 253 client computers connected directly or through 

other hubs and switches to the 4 10/ lOOMbps ports on the GIGAFAST 4-Port Router. 



The GIGAF AST 4-Port Router will then assign IP addresses using its built-in DHCP 

server, allowing client computers to receive TCP/IP settings directly from the router. 

Then through one of the client computers, the GIGAFAST 4-Port Router is configured so 

that all the client computers will be able to share the Internet connection. The front-end 

application is coded with an open database connection to allow users to gain access to the 

server via the Internet. Figure 7 illustrates the network topology for the Findlay Street 

Branch. 

Lnor-Jet 1111 PaflHOIW: KX-P11t1 

Computer4 Computer3 Computer2 

Computer9 

Figure 7. Findlay Street Branch Network Topology 



2.3.3 Administrative Office Protocols 

The Administrative Office currently has voice and data boxes installed in each of 

the individual rooms. The computers are full y networked and sharing a network printer. 

Figure 8 lists the expenses for installing the server. 

Product I Quantity Price I sub Total 

I NETGEAR FEI08 8-Port Hub I $33 .00 I $33 .00 

I CAT-Se I 0/100 Base-T Patch Cable - 25 Feet I 2 $9.00 I $18.00 

I OmniView 2-Port KVM Switch I $89.99 I $89.99 

I OmniView Cable Kit I 2 $14.99 I $29.98 

Total $170.97 

Figure 8. Administrative Branch Budget 

The four computers are running Windows 2000 with Service Pack 1 and 

Microsoft Office XP. A NETGEAR 8 Port Hub was installed on the first floor alloying 

an extra port for the server to connect to the network. To cut expenses an OrnniView 2-

Port KVM Switch was installed. The OmniView 2-Port KVM Switch is the ideal 

solution for system administrators, computer technicians and power users for hassle-free 

control over multiple computers without the additional expense of duplicate keyboards, 

monitors and mice. The Administrative Office has a complete LAN and is Internet ready. 

Contacting Cincinnati Bell will be the next step for the Administrative Office. Cincinnati 

Bell will install a DSL connection to the LAN. A high-speed connection will keep the 

server connected allowing the branches access. Figure 9 lists the expenses for assembling 

the server. 
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Product Quantity I Price I Sub Total 

CH IEFTEC Server Chasis Model DX-0 I BD-420W I I $70.00 I $70.00 

Gigabyte GA-81EXP motherboard I II $133 .00 I $133 .00 

IBM 40GB 7200 RPM Hard Drive I II $70.75 $70.75 

Micron Technology 512MB DDR PC21 00 266M Hz I :I $97.00 $97.00 

Generic CD-R W I I $40.00 $40.00 

Generic Floppy I I $15 .00 $15 .00 

Windows 2000 Advanced Server (25 client) I I $3,749.99 $3 ,749.99 

Microsoft SQL 2000 Enterprise Edition l I 1 $1 o,939.99 $10,939.99 

Microsoft Visual Basic 6.0 Enterprise Edition I I 1 $1 ,429.99 $1 ,429.99 

Microsoft Office 2000 Premium I I I $399.99 $399.99 

I I I I 
I Microsoft Baseline Security Analyzer I I I Free-service I 
I I I I 

~~ ~ I I Total 1$16,945.71 

Figure 9. Server Budget 

2.3.4 Valley Branch Design Protocols 

My examination led to a Network Interface Card upgrade and a local area 

network. The local area network consists of computers located inside the Valley Branch 

and dedicated to the staff of Seven Hills. The computers are networked using a star 

topology. The star topology consists of a central hub from which cable segments radiate 

to each computer on the network. To cut overhead expenses the computers will connect 

to the NETGEAR 8 Port-Hub by way of Category 5 cable and the hub will then tie to a 

router in the client computer lab. The computers will temporarily share the same 

bandwidth Figure 10 lists the expenses. 
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I Product I Quantity I Price I Sub Total 

I NETG EAR 8 Port Hub I I 1 $33 .oo 1 $33 .00 

I NETGEAR I 0/ I 00 PCI Adapter I 5 1$11.oo 1 $55.00 

11 ! I I I 

11 1 I I Total I $88.00 

Figure 10. Valley Branch Budget 

The five computers had a 10MB Allied Telesyn AT-1510 Plug & Play Ethernet 

Adapter. NETGEAR 10/1 00 PCI Adapters were installed in each of the computers 

allowing a faster data transfer. The NETGEAR F A31 OTX is an auto-sensing, 1 OOBASE-

TX Fast Ethernet PCI adapter. It will operate with either 10 Mbps 1 OBASE-T or 100 

Mbps 100BASE-TX hubs or switches. Figure 11lists the Valley Branch 

software/hardware upgrades. 

Allied Telesyn AT- 1510 Plug & 
Play Ethernet Adapter 

Allied Telesyn AT- 1510 Plug& 
Play Ethernet Adapter 

Allied Telesyn AT - 151 0 Plug & 
Play Ethernet Adapter 

Alli ed Telesyn AT- 1510 Plug & 
Play Ethernet Adapter 

Allied Telesyn AT- 151 0 Plug & 
Play Ethernet Adapter 

Computer 1 After Upgrade 

Network Interface Card NETGEAR 10/100 PC! Adapter 

Computer 2 After Upgrade 

Network Interface Card NETGEAR 10/ 100 PCI Adapter 

Computer 3 After Upgrade 

Network Interface Card NETGEAR I 0/100 PC! Adapter 

Computer 4 After Upgrade 

Network Interface Card NETGEAR 10/100 PC! Adapter 

Computer 5 After Upgrade 

Network Interface Card NETGEA R 10/100 PC! Adapter 

Figure 11. Valley Branch Computer Specs 
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A NETGEAR FE108 8-Port Hub was installed and the computers were then 

connected. The NETGEAR FE108 8-Port Hub provides fast information exchange, 

resource sharing, and client or peer-to-peer communication using simple Category 5 

unshielded twisted pair (UTP) wiring. The hub was then wired to the router located in the 

client computer lab. Serving as an advanced firewall , the router prevents hackers from 

entering the private network. The front-end application is coded with an open database 

connection to allow users to gain access to the server via the Internet. Figure 12 illustrates 

the network topology for the Valley Branch. 

Computer 
Lab 

Computer5 

Figure 12. Valley Branch Network Topology 



3 Deliverables 
1. Develop a Wide Area Network consisting of the following offices: 

o Administrative Office 
o Findlay Street Neighborhood House 
o East End Branch 
o Valley Branch 

2. Administrative Office Deliverables 
2.1 Peripherals 

• 1 - NETGEAR FE108 8-Port Hub 
• 1 - OmniView 2-Port KVM Switch 

2.2 Cable Drops 
• 2 - CAT-5e 101100 Base-T Patch Cable - 25 Feet 

2.3 Functionality of the Administrative Office 
• Accommodate the server 

3. Findlay Street Neighborhood House Deliverables 
3.1 Hardware 

• 4 - 64MB PCIOO 
• 8 - NET GEAR F A31 OTX 10/100 PCI 

3.2 Software 
• 3 - Microsoft Windows 2000 Professional Upgrade with Service 

Pack2 
• 3 - Microsoft Office 2000 Premium Upgrade 
• 1 - Microsoft Windows 98 Second Edition Upgrade 
• 3 - Microsoft Office 97 Professional Edition Upgrade 

3.3 Peripherals 
• 1 - GIGAF AST 4-Port Router 
• 1 - NETGEAR FE108 8-Port Hub 

3.4 Cable Drops 
• 5 - CAT-5e 10/100 Base-T Patch Cable - 100 Feet 
• 3 - CAT-5e 101100 Base-T Patch Cable - 50 Feet 
• 1 - CAT-5e 101100 Base-T Patch Cable - 25 Feet 
• 1 - CAT-5e 10/100 Base-T Patch Cable - 7 Feet 

3.5 Functionality of the Findlay Street Neighborhood House 
• Establish a workgroup for the computers 
• Create a local area network so that once the Internet service is 

provided the Findlay Street Neighborhood House can access the 
server via the Internet 

18 



4. East End Branch 
4.1 Hardware 

• 6 - 64MB EDO DIMM 
• 3 - NETGEAR F A31 OTX 10/100 PCI 
• 3 - Seagate 4.3 GB Hard Drive 

4.2 Software 
• 4 - Microsoft Windows 2000 Professional Upgrade with Service 

Pack 2 
• 4 - Microsoft Office 2000 Professional Upgrade 

4.3 Peripherals 
• 1 - GIGAFAST 4-Port Router 

4.4 Cable Drops 
• 4 - CAT-5e 1 011 00 Base-T Patch Cable - 1 00 Feet 

4.5 Functionality of the East End Branch 
• Establish a workgroup for the computers 
• Create a local area network so that once the Internet service is 

provided the East End Branch can access the server via the Internet 

5. Valley Branch Deliverables 
5.1 Hardware 

• 5 - NETGEAR F A31 OTX 101100 PCI 
5.2 Peripherals 

• 1 - NETGEAR 8 Port Hub 
5.3 Functionality of the Valley Branch 

• Establish a workgroup for the computers 
• Create a local area network so that once the Internet service is 

provided the Valley Branch can access the server via the Internet 

6. Server Deliverables (assemble the server using the following hardware/software) 
6.1 Hardware 

• CHIEFTEC Server Model DX-01BD-420W 
• Gigabyte GA-8IEXP Motherboard 
• IBM 40GB 7200 RPM Hard Drive 
• Micron Technology 512MB DDR PC2100 266MHz 
• Sony CD-RW 
• Generic Floppy 

6.2 Software 
• Windows 2000 Advanced Server (25 client) 
• Microsoft SQL 2000 Enterprise Edition 
• Microsoft Office 2000 Premium 
• Microsoft Baseline Security Analyzer 
• Microsoft Visual Basic 6.0 
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6.3 Functionality of the Server 
• Reliable source to store data 
• Highly scalable database 
• Effective table structures and relationships 
• Database normalization to optimize database performance 
• Obtain static IP so that branch offices can access the server via the 

Internet 

6.4 Database Tables 
• Client Table 
• Emergency Contact 
• Client Details 
• 9 Activity Tables 

7. Microsoft Visual Basic 6.0 Front End 
7.1 Functionality of the Front End 

• Provide a means to enter New Client Information via open 
database connection to the server 

• Provide a means to View Client Information via open database 
connection to the server 

• Provide a means to Modify Client Information via open database 
connection to the server 

• Provide a means to enter Client Activities via open database 
connection to the server 

• Provide a means to view Client Statistics and print reports 
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4 Development Timeline 

Senior Design I 
Feasibility Study 01 /07/02 Thru 03/04/02 

Interviews 01 /08/02 Thru 01 / 15/02 
Research 01 /08/02 Thru 03/01/02 
Area of Inquiry 01/28 

Report 02/ 11/02 Thru 03/04/02 
Rough Draft 02/09/02 Thru 02/ 14/02 
First Draft 02/ 14/02 Thru 02/ 19/02 
Final Draft 02/19/02 Thru 03/04/02 

Presentation 02/19/02 Thru 03/04/02 
Slide Preparation 02/ 19/02 Thru 03/0 1/02 
Final Presentation 03/04 

Senior Design II 06/20/02 Thru 08/19/02 
Develop DB Prototype 06/20/02 Thru 06/20/02 

DB Table Design 06/20/02 Thru 08/ 15/02 
Develop Flow Charts 08/08/02 Thru 08/ 15/02 
Testing 06/20/02 Thru 08/ 15/02 

Front End 
Design VB GUI 06/20/02 Thru 08/ 15/02 

Develop Network 06/20/02 Thru 08/ 17/02 
East End Branch 

Software & Hardware Upgrade 06/ 17/02 Thru 06/28/02 
Findlay Street Branch 

Software & Hardware Upgrade 07/01/02 Thru 07/ 12/02 
Valley Branch 07/ 10/02 Thru 07/ 19/02 

Administrative Branch 07/22/02 Thru 08/02/02 
Report 06/20/02 Thru 08/ 19/02 

Rough Draft 06/20/02 Thru 07/27/02 
First Draft 07/25/02 Thru 08/08/02 
Final Draft 08/ 12/02 Thru 08/ 19/02 

Presentation 06/20/02 Thru 08/29/02 
Check Prototype 06/20/02 Thru 08/ 15/02 
Slide Preparation 08/ 12/02 Thru 08/ 19/02 
Final Presentation 811 9 

Senior Design III 01103/03 Thru 03/18/03 
Design Working Product 0 I /03/03 Thru 03/ 17/03 

Final Product Testing 0 I /03/03 Thru 03/ 17/03 
User Beta Testing 02/ 14/03 Thru 03/ 13/03 
Debug Final Product 02/ 14/03 Thru 03/13/03 

Develop User Documentation 0 I I 18/03 Thru 02/1 4/03 
Final Presentation 03/ 18 
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5 Proof of Design 

After executing the application the user is introduced to the Seven Hills 

Neighborhood Houses database by a Splash Screen. The Splash screen is on a three 

second timer. When the three seconds expire the Splash screen unloads and the Main 

Page appears. The users have the option of clicking on the Splash Screen to by-pass the 

timer and unload the screen. Figure 13 is a screen shot of the Splash Screen. , 

SEVEN IITLLS 
NEIGHBORHOOD 

HOUSES 
Copyright © 2003 
Seven Hills Neighborhood Houses 

Database System 
Version 1.0.0 

Figure 13. Splash Screen 

The Main Page proceeds the Splash Screen and allows the user to select from four 

main choices: View I Modify Client Information, Add New Client, Client Activities and 

Metrics. The choices will navigate the user to the corresponding page. The Help Menu 

contains a sub menu that contains technical information concerning the front and back 

end of the application. The File Menu contains a secondary menu to allow the user to exit 

the application. The user is prompt with a message box confirming the exit. The message 

box contains two choices: yes or no. If the user select es the application will save and 

exit the program. The alternative selection will unload and return to the application 
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without the saving. Figure 14 is a screen shot of the Main Page. 

Houses Client Database 

Che t In ormation 

, 

Figure 14. Main Page 

The New Client and View I Modify Client Information is divided into three sub 

sections: Client Information, Demographics and Emergency Contact. The Social Security 

number is formatted so that the user must enter eleven characters, nine numbers and two 

dashes. The user may not enter any character values. There are three fields that are 

required to continue: Social Security Number, First Name and Last Name. If the user tries 

to update the database without filling in a required field a message box will prompt the 

user to fill in the appropriate required field . If the user completes the required fields and 

clicks the Update button a message box will appear prompting the user to save. If the user 

clicks Yes a message box will confirm the save, update the database and refresh the page. 

If the user selects No the applications returns to the page without saving. The Home 

button will return the user to the Main Page. The Help Menu contains a sub menu that 
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contains technical information concerning the front and back end of the application. 

Figure 15 is a screen shot of the View/Modify Client Information Page. 

',. Vtew I Modtfy Cltentlnfotmalt.;~ - - ----~~~-- - r:r. r' 
~:.:~~~~11~~,&~·~, -;.~~-\-;~tit._.,u. ·,~;~' t, ·~.k .. ~ 

Client Jnf ormation 
View I ltf odify Client Information 

Social Secunty Number I 
'------' 

Last Name f. r tN 11 

Street Addn, 

City 

State 

Phone Numbet 

Demographics 

Emereency Contact 

Figure 15. View I Modify Client Information Page 

Figure 16 is a screen shot of the New Client Information Page. 

Enter New Client Information 
Client Jnf ormation 

F1rst Name 

Street Address 

Phone Number 

Emergency Contact 

Figure 16. New Client Information Page 
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The Client Activities page is divided into three sections: Client Information, 

Services and The Calendar. The user can simply scroll through the recordset until they 

find the correct client and then update client information. The Client Information is 

displayed using label boxes so the user is unable to modify the information. The services 

are arranged in a Tabbed Dialog Control allowing the user to select the correct tab and 

continue to check the activities. After selecting the activities the user can select the date 

using the Calendar Control. After selecting the date the Enter button will prompt the user 

with a message box verifying the save. The Home button will return the user to the Main 

Page. The Help Menu contains a sub menu that contains technical information 

concerning the front and back end of the application. Figure 1 7 is a screen shot of the 

Client Activities Page. 

Client Infonnation 

Social Security Number 

Last Name 

Client Activities 

Middle First Name 

Figure 17. Client Activities Page 

5 6 7 
12 13 14 
19 20 21 
26 4D 28 
5 6 7 

J 
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The Metrics Page contains two buttons: View Metrics and Home. The View 

Metrics button will open a Microsoft Excel page retrieve the data from the database and 

display the data using a Pivot Table. The Home button will return the user to the Main 

Page. The Help Menu contains a sub menu that contains technical information 

concerning the front and back end of the application. Figure 18 is a screen shot of the 

Metrics Page. 

Client/ Activities Metrics 

Figure 18. Metrics Page 

The Pivot Table is an interactive table that enables the user to group and 

summarize an Excel list into concise, tabular format for easier reporting and analysis. 

Figure 19 is a screen shot of the Pivot Table. 

111212002 
2{2/2002 

4/18/2002 
51512002 

5{22/2002 
2/112003 

2{28/2003 
3/1912003 

Figure 19. Pivot Table 
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6 Conclusions and Recommendations 

Simple. reliable acces9 to the Nee. 

http:/ /www.fuse.net/ 

The next step for Seven Hills Neighborhood Houses is to contact Cincinnati Bell 

and request a high speed Internet connection for the following offices: East End Branch, 

Findlay Street Branch and Valle Branch. Once the WAN is complete install the front-

end application at the client computers at the branch offices allowing instant access to the 

Server. The branch offices can then View/Modify Client Information, Add New Clients, 

assign Client Activities and generate Metrics. The Administrative Office holds the 

document for adding the application to client computers. B enhancing the Internet 

connection with ZoomTown high-speed Internet access it will eliminate the idle time 

spent dialing into the Internet, drastically speed up downloading, and let them use the 

phone when their online. ZoomTown has four flexible service offerings so they can 

choose the one that best suits Seven Hills. Figure 20 lists the ZoomTown expenses. The 

LANs are set up with a static sub net mask. I would also recommend a mail server to 

further increase the efficiency and capability of sharing information. 
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Standard Pricing 
ZoomTown with Fuse 

ADSL Option 

ZoomTown With Fuse 
Internet Access 

ZoomTown HyperSpeed 
With Fuse Internet Access 

ZoomTown Home Office 
With Fuse Internet Access 

includes I static IP 

ZoomTown With 
Participating ISP 

ZoomTown HyperSpeed 
With Participating ISP 

ZoomTown Home Office 
With Participating ISP 

includes I static IP 

Speed Price 
$19.95/mo. for 3 months 

Up to 768 Kbps download 
Offer expires 3/31 /2003! 

$41 .95 per month regular price 
and 384 Kbps upload applies after the third month. 

Up to 1.5 Mbps download 
$59.95 per month 

and 768 Kbps upload 

Up to 768 Kbps download $49.95 per month 
and 384 Kbps upload 

$9.95/mo. for 3 months 
Up to 768 Kbps download Offer expires 3/3 1/2003! 

and 384 Kbps upload $29.95 per month regu lar price 
applies after the third month . 

Up to 1.5 Mbps download 
$47.95 per month 

and 768 Kbps upload 

Up to 768 Kbps download $43.95 per month 
and 384 Kbps up load 

Figure 20. ZoomTown expenses 
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Appendix A. Relationship Diagram 

Emolovment Service I Theraoeutic Counseljl 
IJ!.I Activities []J Activities 

[EmergencY 
[U!JActivities Activities IH Sociai_Security _Number 

Activities Youth Development 
[supplemental Educall J] ~~[Date] [[JUActivities 
[WActivities I 

~ I 

I Family ure Educati!:!_l 
[L!JActivities 

[Senior Services 
-I [[]}Activities 

Emergency Contact Client InFormation 
_ Emen;Jency _First_Name I'"- First_Name I Neiahborhood Oraanjl 
_ Emen;Jency_Middle_Name li-- Middle_Name [[]J Activities 
_ Emen;Jency _Last_Name I'-= Last_Name 
_ Emen;Jency_Phone_Numbo 

1
.J!. Sociai_Security _Number 

!Kids I!< Teens USA -1 ,..-- Emen;Jency _Relation li-- Street_Address 
[._!!Activities ,__ Sociai_Security _Number I'-- City 

I'- State 
I- Zip 
II-- Phone_Number 
I'-- Gender 
f-- Age 
f-- Ethnicity 
f-- County 

I 
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